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InDesign Template Print-to-Digital Best Practices Guide for 
Digital Export   

The following is a guide of best practices for how to best set up InDesign templates  

to make XML digital export from the new engine more successful. 
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Clearing the Pasteboard 

Remove any text frames and/or linked images from the pasteboard. Otherwise they  

risk being exported and causing confusion as this would not be wanted content for the digital 

application. 

Consistent Style Sheet Name Application 

Apply Paragraph and Character style sheets names consistently in order for the content to be 

treated as a unique element on the digital side. 

Note: In order for content to be easily assessed and understood across the Composition team 

and Development team, we recommend assigning unique name(s) to pieces of content. Even 

though the Composition team might not know the app's final design, they can prepare content 

for the Development team by naming content into sections and subsections by applying unique 

names to element labels, paragraphs, and character styles. This approach will also help with 

creating XML Rules for future templates. 

Bold and Italic 

The production team can determine unique style names to describe what is intended for the 

content; bold and italic styling doesn't need to be named "bold" or "italic." Just apply proper 

styles to this content; the engine will translate those in the export.  

Note on Block quotes: In past templates, block quotes were used. If it is ever used again, 

assigning a unique paragraph/character style name, “Blockquote,” to this content will work. 
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Overrides 

The engine captures local overrides. If local 

overrides are applied to content in the 

templates, a Compositor's Best practice should 

be to get them fixed before running the engine. 

Still, the engine captures all overrides at the 

corresponding element tags. 

Sidebar Content 

Sidebar content, like in the example (from Short Reads 

Decodable TG Lesson Template), is not used in all of the 

templates. The styles applied to the heads in sidebar content 

separates it for the engine into sections. The number of sections 

is not limited to the number of sections you see in the example. 

Therefore, sections in sidebar content will vary, and style sheets 

should be flexible to allow the number of sections needed. We 

call this  

Generic styling.  

Generic styling is styling sections with a more boilerplate naming 

convention. The sections in the sidebar content  

(for example, the headers in blue) are not bound to the name of 

the style sheet. Generic styling provides a more universal way of 

separating content for the engine: 

Example: “Sidebar- B-Hed” 

Customized styling can also be applied to sidebar content if the sections of content  

do not change and remain in the same order.  
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Examples: “Sidebar- Genre-Hed” and “Sidebar- Phonics-Focus-Hed” 

Note: This requires stricter validation for the engine and will validate only if these sections do 

not change and remain in the same order.  

These two kinds of styling work for the engine. The engine can handle both.  

We are including both options for future projects in case a Customized Styling vs.  

a Generic styling is needed.  

A recap of the Styling recommended:  

1. Generic Styling - the style applied for each blue sidebar header should all be  

the same, being consistent with the use of the paragraph style as it is now in  

the current templates. This approach allows for creating a single rule that can capture 

an arbitrary amount of sections.  

2. Customized Styling - the style for each blue sidebar header should be unique (for 

example, Sidebar-Generic-Hed, Sidebar-Phonic-Hed, etc.) This approach allows for 

creating a single rule when there is a definitive need to target a specific section.  

Generic Styling is the best-recommended approach for creating styles for the engine.  

Note: There might be cases when sections of content are unique enough that might require 

customized paragraph style sheet names. 

Teacher Script 

Teacher scripts are styled “italic.” If the design treatment of teacher scripts needs to be 

changed into a more customized look, then a unique character style name must be given in 

order for the Dev team to know that it requires a different treatment. For example, if the new 

design treatment requires the color to change to purple, then the unique name should be 

“Teacher Script” to reflect the Teacher Script content.  
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Avoiding Paragraph Returns and Applying Soft Returns 

Avoid applying a paragraph return to a sentence in a paragraph. When you apply a paragraph 

return, the content that follows after the paragraph return splits into a new tag. Applying a soft 

return keeps the content together in one tag, which is correct. See below examples for 

reference. Correct: Applying a soft return to a sentence in a paragraph keeps content together 

in one tag. Incorrect: Applying a paragraph return to a sentence in a paragraph splits the 

content into two separate tags. 

CORRECT 

 

 
INCORRECT 
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Ordered/Numbered Lists and Checklists 

List items should only be created with paragraph style sheets. If a List type (Ordered, 

Numbered, or Checklists) is styled differently, a unique paragraph and character style name(s) 

needs to be applied. While we didn’t find any examples of this in the Ready for Reading 

templates, it is a good practice to keep in mind in the future to do so.  

Here are some examples: 

● Items that have special icons instead of bullets or numbers 

○ Past File Example 

BL_TG_G1U1_W03D2_090-095 

 

○ Current Test File Example 

TEST_Short Reads Decodable_TG_Lesson_Template_ATOMIC_BestPract 

 

XML Results 

 

● Items with hanging indents, with or without n-dashes 

○ Past File Example  

BL_TG_G1U1_W03D2_090-095 
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○ Current Test File Example 

TEST_Short Reads Decodable_TG_Lesson_Template_ATOMIC_BestPract 

 

XML Results 

 

● Items that have a specific color that needs to translate into digital 

○ Past File Example 

EC3-5_TG_Eng_Lang_T2W02_028-037 
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○ Current Test File Example 

TEST_Short Reads Decodable_TG_Lesson_Template_ATOMIC_BestPract 

 

XML Results 

 

● Reverse number order 

The number in the bullet list gets converted as text. The number is no longer embedded 

in the paragraph style sheet.  
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○ Current Test File Example 

TEST_Short Reads Decodable_TG_Lesson_Template_ATOMIC_BestPract 

  

XML Results 

 

Outlined (or Circled) Text for Emphasis in Instruction 

Assign unique paragraph/character style name(s) to this content consistently in order for the 

content to be treated as a unique element on the digital side.  

Icons 

Graphic symbols that can serve as decorative art or serve as a function for a program. Icons are 

created in multiple ways. Below are a few examples found in the templates. 

Embedded icons with external image links that need to appear in line with the text in the App 

are images that get extracted like all other images. 
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1) In the box unit below, both print and digital contain the icon art. The source file contains 

no distinguishing style sheets to indicate "Multilingual Learners." 

Best Practice:  

○ This content will need a unique 

style applied to the header 

content or an element label to 

the text box so that it can be 

associated  

with an icon on the Dev/App end.  

Note: A test was made in Wiley Blevins-Word Study Card_template against the engine, 

and the icon (currently not set as an inline graphic) "WB_icon_multilingual.ai" in sidebar 

content step 2 section 2, does appear in the transformation XML inline with the sidebar 

content following.  

Indesign Test file 
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2) Lozenges that have icons in print will appear the same in digital: 

Read to Know TG Lesson Review 

● Print Icon below found in the Read to Know TG Review Lesson Template is a 

grouped object embedded in the paragraph.       

 

● Digital  Icon appearing on the App  

 

Best Practice 

● This type of content needs a character style, “Lozenge” applied to it.  

Icons with external image links in the R4R provided templates 

Wiley Blevins Lessons 

 

Read to Know Lesson and Lesson Reviews 

 

 

 

Example File  
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Upper Case/Small Case Text 

To ensure the correct font style rendering in digital for Upper Case and Small Case,  

the tool can/will read the All Caps/Small Caps however they are applied. Naturally, the best 

approach is setting the Case style in the paragraph style sheet.  

To show how the engine works with “Cases,” we set two scenarios of how “Cases”  

are applied. The engine captures them differently: 

1) Applying “Cases” in the Paragraph Style  

 

 
2) Applying “Cases” using the Text Palette  

  

XML Results (Upper Case All Caps Text) 
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2 are successful but different results 

 

 

2) Selecting the desired text and changing the “Case” 

a) Select Text > Right click > Menu > Change Case 

● Selecting text and changing the case will appear correctly  

in the range tag. <range capitalization=”ALL-CAPS”>  

tag to the content in the XML 

 

XML Results 
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b) Select Text > Properties Menu > Change Case 

Note: This approach is NOT a Best Practice approach. The ideal 

approaches are the recommendations listed above. 

● Selecting text and changing the case will NOT apply a <range 

capitalization=”ALL-CAPS” > tag to the content in the XML 

 

XML Results 

 

Text Columns/Row Spacing & Layout 

This applies to situations where consistent whitespace between words and/or sentences on a 

single line are needed. (It does not apply to multiple lines intended to line up neatly into 

columns. The latter would be solved either with tabs or tables.) 

There are two ways of applying whitespace throughout a single line of content:  

● Customized Whitespace (present in the RTM Short Decodables template) 

● Placing content in tables. 
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The following are examples of the InDesign layout and the XML Results   

Text Columns/Row Spacing & Layout Examples 

● Customized Whitespace (present in the Short Decodable template) 

● Replacing Whitespace with Unicode (adding a Unicode replacement  

based on the Unicode matrix provided. See Special Characters section) 

Creating content as a table 

InDesign File 

 

Note: The best practice approach is applying a unique paragraph style sheet  

like in the Short Reads Decodable Teacher Guide template 

XML Results for all Special Characters and Whitespaces 

To match custom spacing in print for digital, in the digital matrix provided  

ACE-94 Special Characters, assigning a special character to say, six blank  

spaces is an approach.  

 

https://scholastic-my.sharepoint.com/:f:/p/joellop/Ei7T8AU7E8FNtzihOvGiCDEBCy4NCW7RLXywhfBEAsvOkw?e=SXGueS
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In addition to assigning special characters to spacing, another recommended approach would 

be to apply a character style sheet such as “blank-space-2" or "blank-space-3”  to any current 

space characters; the number added would be the number of spaces desired between the 

words.  

Fill in The Blanks/Write-on Lines (WOL) 

Fill in the blanks and write-on lines are blank lines giving the reader the task to replace them 

with missing content. Currently, write-on lines are created with the character style “In-Line 

Graphic” (found in the Wiley Blevins Word Study Card Template.) The issue is that in some fonts 

in digital, multiple consecutive underscores may present as a white gap instead of a contiguous 

line; this depends on the font and can be different from print to digital.  

As a recommended approach for the engine, fill-in-the-blanks and write-on lines should be 

consistently applied with unique character-style names. Decide on the different fill-in-the-blank 

lengths, for example, short, medium, long, and full width. Agreeing on a standard will help 

maintain consistency for rendering them in the application. There are two ways to apply fill-in-

the-blanks and write-on lines: 

● As Paragraph Styles and Character Styles 

Note: Font families/typefaces are not being passed in the target XML because our application 

does not read them. Any special font added to that section of text would not appear. 

Write-on-Lines Using Paragraph styles and Character styles 

Applying a unique paragraph style and/or a character style to a write-on-line (WOL) provides 

the Dev team an indicator that a write-on line is needed. It also gives markers when creating an 

XML Rule.  

In the example below, the write-on lines styled with paragraph styles and character styles are 

given unique names. The paragraph style is Body (normal). The character style is where the 
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unique names are given. The WOL is created using the underline options and hitting the 

spacebar.  

Note: WOL with an underline and hitting the spacebar (i.e., 20 spaces) will collapse to one 

space in the XML export (implicit rule). 

Best recommended approach: 2 character style sheet for 2 WOLs.  

● Character style sheet: Write-On Line  

● Paragraph style sheet: Write-On Line Full Width  

Vocab Terms/Glossary Words/Key Words  

If these become part of a glossary, it will be essential to know what these are so the export 

process can handle them. Because this type of content is at the character level, a unique 

character style name needs to get applied to this content. The engine will extract the style 

name.  

Note: The character style name given is under <range> in the XML data. 

Content for Different States  

Content to be extracted for different states’ versions, like for California or Georgia, placed on 

separate layers. The engine is able to extract layers from InDesign and target the layer names. 

In the test case below, three layers were used, California, Georgia, and National (base layer). On 

each layer, content tested, “Review Book X”, was intentionally modified for the test. 

InDesign File Example 

TEST-Content-Different-States-ATOMIC 

 
Georgia Layer (ATOMIC TEST - GA) 
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California Layer (ATOMIC TEST - CA) 

 
Base Layer (ATOMIC TEST - BASE) 

XML Results 

 
All Layers 

 
Georgia Layer 
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California Layer 

 
Base Layer (National) 

Threaded Text Boxes 

InDesign text stories flowing to multiple boxes are “threaded” (linked). This approach in 

InDesign does not affect the engine. It can extract the content correctly and in the correct 

order. As a test case, we used the Read to Know TG Review Lesson, creating threaded text 

frames, and no issues were found. 

Side Note: This has no bearing on content getting extracted, but as reference,  

in the XML Transformation, the engine gives markers when threaded content  

begins and ends.  

Credits  

Assign a unique paragraph/character style named, “Credits” to this content in order for the 

content to be treated as a unique element on the digital side. 

Image “Display-Order” 

The engine captures images but not in order. Compositors can add element labels to images so 

the digital app can know how they appear.  
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Note: Please follow the established naming convention to correctly name element labels. 

 However, if wireframe mapping for the digital app are available, you can name element labels 

to images in accordance to what the naming convention the Dev team will use for the digital 

app.  

The Wiley Blevins Word Study Card template, WBTPK3_2023_WSLC_Plurals, is a perfect 

example of this. In the InDesign file, the names of the element labels for the images in the 

Overview section were named to align with the naming convention the Dev team will use.   

InDesign File  

WBTPK3_2023_WSLC_Plurals 

 

Wireframe Mapping - Wiley Blevins Overview Section 

 

Special Characters  

Special Characters (glyphs) are non-alphanumeric characters that can be rendered on  

a standard, American-English keyboard. They are features (glyphs) used in everyday content. 

Examples: ® and ™. Soft returns and no break characters translate to a single space in the App. 

The XML converts these special characters to their encoded Unicode standard. A complete list 

of all the special characters within InDesign are below and provided in ACE-94; the export 

processes will ensure the handling of all of these characters. However, the composition team 

https://jira.sts.scholastic.com/browse/ACE-94
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will need to update characters, not exporting as expected. Determine the best way to render 

these before transferring them to the App via a preview tool: Unicode Converter 

Special Characters Matrix  

The Special Characters Matrix below is also available here: Matrix (Excel Sheet. 

Name Definition Unicode Symbol 

ARABIC_COMMA Inserts an Arabic 
comma. 

U+060C ، 

ARABIC_KASHIDA Inserts an Arabic 
kashida. 

U+0640 NA 
kashida inserted to stretch 
characters or to carry 
tashkil with no base letter 
also used with Adlam, 
Hanifi Rohingya, Mandaic, 
Manichaean, Psalter 
Pahlavi, Sogdian, and 
Syriac 

ARABIC_QUESTION_MARK Inserts an Arabic 
question mark. 

U+061F ؟ 

ARABIC_SEMICOLON Inserts an Arabic 
semicolon. 

U+061B ؛ 

AUTO_PAGE_NUMBER Inserts an automatic 
page number. 

NA (No 
Space) 

NA (Hidden Character) 
Note: Hexa: 5341706E 

BULLET_CHARACTER Inserts a bullet 
character. 

U+2022 • 

COLUMN_BREAK Inserts a column break.  
NA (Single 
Space) 

"NA (Hidden Character) 
Note: Hexa: 53436C42" 

https://r12a.github.io/app-conversion/
https://scholastic-my.sharepoint.com/:x:/p/joellop/EUOoLQytokJPqMB0b8BIRy4BWr9jfHKyER9bPlOHp0rKtA?e=hhrepD
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COPYRIGHT_SYMBOL Inserts a copyright 
symbol. 

U+00A9 © 

DEGREE_SYMBOL Inserts a degree symbol. U+00B0 ° 

DISCRETIONARY_HYPHEN Inserts a discretionary 
hyphen. 

U+00AD NA (Hidden Character) 
A discretionary hyphen is 
manually inserted where 
you, the user, want a word 
to break if and when that 
word appears at the end 
of a line. If the text 
reflows and the need for 
hyphenation is eliminated, 
the hyphen disappears. 

DISCRETIONARY_LINE_BREAK Inserts a discretionary 
line break. 

 
U+200B 

NA (Hidden Character) 
The difference between 
the two is that the former, 
the discretionary hyphen, 
breaks with a hyphen 
while a DLB just breaks, 
sans hyphen. DLBs are 
useful as occasional 
substitutes for manual line 
breaks or soft returns. 

DOTTED_CIRCLE Inserts a dotted circle. U+25CC ◌ 

DOUBLE_LEFT_QUOTE Inserts a double left 
quote. 

U+201C “ 

DOUBLE_RIGHT_QUOTE Inserts a double right 
quote. 

U+201D " 

DOUBLE_STRAIGHT_QUOTE Inserts a double straight 
quote. 

U+201C " 
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ELLIPSIS_CHARACTER Inserts an ellipsis 
character. 

U+2026 … 

EM_DASH Inserts an em dash. U+2014 — 

EM_SPACE Inserts an em space. U+2003 NA (Hidden Character) 

END_NESTED_STYLE Inserts an end nested 
style here character. 

NA (No 
Space) 

NA (Hidden Character) 

EN_DASH Inserts an en dash. U+2014 – 

EN_SPACE Inserts an en space. U+0020 NA (Hidden Character) 

EVEN_PAGE_BREAK Inserts a break to the 
next even page. 

NA (No 
Space) 

Hidden Character 
Asterisks are among the 
most common symbols 
used to indicate section 
breaks in a book. 

FIGURE_SPACE Inserts a figure space. U+2007 NA (Hidden Character) 

FIXED_WIDTH_NONBREAKING_SPACE Inserts a fixed-width 
nonbreaking space. 

U+00A0 NA (Hidden Character) 

FLUSH_SPACE Inserts a flush space. NA (Single 
Space) 

NA (Hidden Character) 

FOOTNOTE_SYMBOL Inserts a footnote 
symbol. 

NA (No 
Space) 

*, †, ‡, §, ‖, ¶ 
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FORCED_LINE_BREAK Inserts a forced line 
break. 

U+000C  NA (Hidden Character) 

FRAME_BREAK Inserts a frame break. NA (No 
Space) 

NA (Hidden Character) 

HAIR_SPACE Inserts a hair space. U+200A NA (Hidden Character) 

HEBREW_GERESH Inserts a hebrew geresh. U+05F3 ׳ 

HEBREW_GERSHAYIM Inserts a hebrew 
gershayim. 

U+05F4 ״ 

HEBREW_MAQAF Inserts a hebrew maqaf. U+05Be  

 ־

HEBREW_SOF_PASUK Inserts a hebrew sof 
pasuk. 

U+05C3 ׃ 

INDENT_HERE_TAB Inserts an indent to the 
character. 

NA (Single 
Space) 

NA (Hidden Character) 

LEFT_TO_RIGHT_EMBEDDING Inserts a left to right 
embedding mark. 

U+202A NA (Hidden Character) 

LEFT_TO_RIGHT_MARK Inserts a left to right 
mark. 

U+200E NA (Hidden Character) 

LEFT_TO_RIGHT_OVERRIDE Inserts a left to right 
override mark. 

U+202D NA (Hidden Character) 
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NEXT_PAGE_NUMBER Inserts the next page 
number. 

U+2398 NA (Hidden Character) 

NONBREAKING_HYPHEN Inserts a nonbreaking 
hyphen. 

U+2011 NA (Hidden Character) 

NONBREAKING_SPACE Inserts a nonbreaking 
space. 

U+00A0 NA (Hidden Character) 

ODD_PAGE_BREAK Inserts a break to the 
next odd page. 

NA (Single 
Space) 

NA (Hidden Character) 

PAGE_BREAK Inserts a page break. NA (Single 
Space) 

Hidden Character. 
Asterisks are among the 
most common symbols 
used to indicate section 
breaks in a book. 

PARAGRAPH_SYMBOL Inserts a paragraph 
symbol. 

U+00B6 ¶ 

POP_DIRECTIONAL_FORMATTING Inserts a pop directional 
formatting mark. 

U+202C NA (Hidden Character) 

PREVIOUS_PAGE_NUMBER Inserts the previous 
page number. 

NA (No 
Space) 

NA (Hidden Character) 

PUNCTUATION_SPACE Inserts a punctuation 
space. 

U+0020 NA (Hidden Character) 

QUARTER_SPACE Inserts a quarter-width 
space. 

U+0020 NA (Hidden Character) 

REGISTERED_TRADEMARK Inserts a registered 
trademark. 

U+00AE ® 
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RIGHT_INDENT_TAB Inserts a right indent 
tab. 

NA (Single 
Space) 

NA (Hidden Character) 

RIGHT_TO_LEFT_EMBEDDING Inserts a right to left 
embedding mark. 

U+202B NA (Hidden Character) 

RIGHT_TO_LEFT_MARK Inserts a right to left 
mark. 

U+200F NA (Hidden Character) 

RIGHT_TO_LEFT_OVERRIDE Inserts a right to left 
override mark. 

U+202E NA (Hidden Character) 

SECTION_MARKER Inserts a section marker. NA (No 
Space) 

NA (Hidden Character) 

SECTION_SYMBOL Inserts a section symbol. U+00A7 NA (Hidden Character) 

SINGLE_LEFT_QUOTE Inserts a single left 
quote. 

U+2018 ' 

SINGLE_RIGHT_QUOTE Inserts a single right 
quote. 

U+0027 ' 

SINGLE_STRAIGHT_QUOTE Inserts a single straight 
quote. 

U+0027 ' 

SIXTH_SPACE Inserts a sixth-width 
space. 

U+2006 NA (Hidden Character) 

TEXT_VARIABLE Inserts the specified text 
variable. 

NA (No 
Space) 

NA (Hidden Character) 

THIN_SPACE Inserts a thin space. U+2009 NA (Hidden Character) 
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THIRD_SPACE Inserts a third-width 
space. 

NA (Single 
Space) 

NA (Hidden Character) 

TRADEMARK_SYMBOL Inserts a trademark 
symbol. 

U+2122 ™ 

ZERO_WIDTH_JOINER Inserts a zero width 
joiner. 

U+200D NA (Hidden Character) 

ZERO_WIDTH_NONJOINER Inserts a zero-width 
non-joiner. 

U+200C NA (Hidden Character) 

Special White Space 

Whitespace used in print gets converted by the engine as a single space. If customized space 

gets applied, a Unicode is needed for the engine to convert the customized space correctly. It 

will take the Unicode and translate it to the customized space.  

You can use the Unicode Matrix provided in ACE-94 - Special Characters to find the correct 

Unicode.    

  

● Em Space      •   En Space  

● Nonbreaking Space    •   Nonbreaking Space (FixedWidth) 

● Hair Space      •   Sixth Space  

● Thin Space      •   Quarter Space 

● Third Space      •   Punctuation Space  

● Figure Space     •    Flush Space  

XML Results (Whitespace) 

https://scholastic-my.sharepoint.com/:f:/p/joellop/EmmiDhpgrtZKuW9YiH6cpoYBUm1EKCg9a3ThDbXm7DhUmQ?e=M1homi
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A Style Applied When Style is not present in the Font Family 

When there is a case where content is styled, and the font is not in the font family of the font, 

the engine will fail from the start. It will not run. In the case example “TEST_Wiley Blevins-

Alphabet Lesson_template_ATOMIC,” the style “Heavy Italic” is applied to the running header, 

but the character style “Black italic” is applied.  

The engine will fail. 

 

The engine fails to run from the start because “Black italic” is not part of the Font 

 Family Report School. The correct font family that needs to get used is “Heavy Italic.”  

“Heavy italic” is part of the Report School font family. 
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If an error like this occurs:  

● Review character styles in InDesign file,  

make sure the style in the font family exists 

and is correct in the Character Style panel, go 

to “Edit” and open the Character Style 

Options window.  

On the left side of the window, scroll down to 

“Basic Character Formats” and then go to 

“Font Family.” 

In the “Font Family" field, type in the font name (in the example it is Report School font).  

By typing in the font name the font family will appear. There you can see  

if the font style was correctly applied. 

Element Labels  

Element labels target content at the item frame level (one level above the text frame). Applying 

element labels to text frames organizes the content, simplifying XML Rules.  
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It also allows you to further target content at the; text frame, paragraph, and character level. 

See the Best Practice section, “Element Labels with Separated Text Frames for Creating Rules,” 

for more information. 

InDesign File Example (Set up to test Element Labels) 

ATOMIC_Short Reads Decodable_TG_Lesson_Template_TEST_Element_Labels 

   

XML Results  

ATOMIC_Short Reads Decodable_TG_Lesson_Template_TEST_Element_Labels_transformed.xml 

 

Text Frames  

Text frames help group and organize content into sections. Text Frames are important because 

tagging element labels to them act as markers when creating XML Rules. Applying element 

labels to text frames is recommended in creating XML Rules. In doing so, all the content in that 

text frame gets tagged at the most top-level (even before the text frame), simplifying the XML 

Rules. 

Note: A recommended approach is separating content into individual text frames per section. 

See the Best Practice section, “Element Labels with Separated Text Frames for Creating Rules.” 

InDesign File Example (Set up to test Separate Text Frames) 
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ATOMIC_Short Reads Decodable_TG_Lesson_Template_TEST_Element_Labels 

 

Element Labels with Separated Text Frames for Creating XML Rules 

Using element labels with separated text frames is our recommended Best Practice approach to 

separating content. Tagging this way structures, isolates, and groups content more precisely. It 

also helps to create more generic XML Rules that do not target specific content. For example, 

when creating an XML Rule, markers are needed.  

Markers are designated points targeting pieces of content that the engine captures and parses. 

Markers assigned to an element label are at the item level (top level, meaning one above text 

frame level). This allows you the flexibility to use additional markers (if needed) at the text 

frame, paragraph style, and character style. Element labels with separated text frames contain 

sections of content from the title through the end of a paragraph. Content with multiple 

sections (multiple titles and paragraphs) in one text frame will require XML rules that look at 

specific content to capture and separate content into sections. While this is not wrong, it 

creates more work and a less generic XMl Rule file. Applying XML Rules with element labels in 

separated text frames simplifies the process because the content is isolated and contained in 

the element label and text frame. We created two XML Rule files, one using element labels and 
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separated text frames (Wiley Blevins ACE-28) and the other without (Read to Know TG 

Review Lesson ACE-93). You can see how using element labels with separated text frames 

makes the content more structured and organized. 

Metadata  

When we talk about metadata in this Best Practice document, we only reference metadata that 

will be a part of the composition workflow within InDesign/InCopy/Woodwing. We have 

defined that metadata to be the skills, unique UUIDs, Lesson IDs, Alt Text, and Cross-reference 

content; below are more details on each type. 

Skills 

● Skill metadata will be added via WoodWing custom metadata fields tied to a WoodWing 

database object (Layout and/or Article). The Production team will provide directions on 

how to add these skills. 

https://jira.sts.scholastic.com/secure/RapidBoard.jspa?rapidView=1829&projectKey=ACE&view=detail&selectedIssue=ACE-28
https://jira.sts.scholastic.com/secure/RapidBoard.jspa?rapidView=1829&projectKey=ACE&view=detail&selectedIssue=ACE-93
https://jira.sts.scholastic.com/secure/RapidBoard.jspa?rapidView=1829&projectKey=ACE&view=detail&selectedIssue=ACE-93
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● XML Results (Skills Metadata) 
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UUID Lesson IDs 

● Unique Lesson Identifier added via WoodWing custom metadata fields tied to a 

WoodWing database object (Layout and/or Article). Atomic to extract this data in 

XML/JSON. The Production team will provide directions on how to add these. 

○ Felicia will create and assign the Lesson Ids in File Maker. Stephen and Joel will 

add these Ids to Woodwing. 

 

 

For reference, we did a local test with the InDesign file on WoodWing Stage:  

TEST Lesson GUID-R2K_TG_TextSet07_Bones_061-066-ATOMIC  
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XML Metadata Results  

Note: Testing locally, the metadata is extracted in a separate XML file.  

The reference below will not look like how the final data will look.  

The final data will appear with all other data in one XML file.   
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Alt Text  

Adding Alt-text (Long and Short) embedded in image XMP was the desired approach. To 

see more information on how to add the Alt Text go to this document: ACE-86 Example 

InDesign files that Include Images with XMP AltText and Long Text. The test file used in 

ACE-86 has both Long and Short Alt Text cases where the Alt Text was placed in the 

Keywords and Description fields. 

Note: This approach applies to ALL embedded images that are linked. As such, the 

engine checks to see whether they have alt-text or not. Any image that has a link gets 

checked for alt-text. The only time that it doesn't is when you copy/paste an image into 

InDesign. 

Limitations for Alt Text embedded within an image 

● The same image is being used in multiple places and requires  

different descriptions. 

● The context of the alt-text changes when the image is cropped. 

Note: These are Limitations for the Alt Text embedded within an image  

because alt text is being pulled from XMP.  If you were to crop and create multiple 

images in InDesign based on the same source image, all these  

images will have the same alt-text. 

Best Practice Approach 

● Add Object Export Options > Alt Text field but it will only live in the InDesign file 

where the image is.  

https://scholastic-my.sharepoint.com/:b:/p/joellop/EeDRXoN_NSFFnqjUHml7ESABqqvJQB0-AZd8Tvnlf4E5qA?e=YMdWSO
https://scholastic-my.sharepoint.com/:b:/p/joellop/EeDRXoN_NSFFnqjUHml7ESABqqvJQB0-AZd8Tvnlf4E5qA?e=YMdWSO
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Cross-Reference Content 

In print, a cross-reference is a marker that tells the reader that there is relevant or more 

detailed information in another part of the book. 

Wiley Blevins-Word Study Card_template  
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Cross-References need to be changed for digital, for example, the page reference vs.  

a link to the lesson for digital. To see more details on how to add cross-reference content as 

conditional text in InDesign, review the documentation attached to ticket ACE-83 (ACE-83-

CROSS REF InDesign EX FILE Conditional Text for Print vs Digital) 

The ID information needed to add cross-reference content can be found on StagingArea 

location: 

/nyedproduct01.corp.scholasticinc.local/StagingArea/AutomatedXML/Generic_Content_Deliver

y_Imports/[PROJECTCODE]/Metadata/ 

The types of cross-reference content might include: 

● A Limelight Video ID, the resource to these IDs is found in Limelight. 

○ Example: digital-video_id: ffa6e2053b5b45e5817dd946f1423837 

● PDF IDs, the resource to these IDs can be found in the R4R_RESOURCES.csv in 

the StagingArea location listed above. 

○ Example: digital-pdf_id: r4r_res_0001   

● EPUB IDs, the resource to these IDs for RTK are found in R4R_RTK_TEXTS.csv, the 

Short Reads ones are in R4R_SR_CARDS.csv (their IDs will look a bit different). 

These can be found in the StagingArea location listed above 

○ Example: digital-epub_id: rtk_text_0005 

● Lesson ID: the resource to these IDs can be found in the R4R_LESSONS.csv, which 

contains metadata about each lesson.  

The first column has lesson ids.  

○ Example: digital-lesson_id:  r4r_lesson_0000 

● Digital Text: this resource would be coming from the editorial if it is something 

that is desired. The idea is that this would be text that would replace what's in 

print with something different for digital content. 

○ Example: digital-text: “in Lesson 1.2” 

https://scholastic-my.sharepoint.com/:f:/p/joellop/EhFLXsj3Bk9Egzxy8EbUx1wBZhT9qNe2m9KBB2REy-CtWA?e=dAWtNV
https://scholastic-my.sharepoint.com/:f:/p/joellop/EhFLXsj3Bk9Egzxy8EbUx1wBZhT9qNe2m9KBB2REy-CtWA?e=dAWtNV
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● Suppress Text: if content needs to be suppressed (not shown) in the App, apply a 

conditional digital text but do not add any content. In the XML, you will still see 

the string of text you want to suppress, but it will have an attribute of 

condition=”digital-text: ” Engineering will know that if there is no content, it will 

get suppressed. 

○ Example: digital-text:  

Conditional Text applied for Suppress Text 

InDesign Test File: TEST-Suppressed Content-Atomic 

 
Target XML 

 

● WB activities: For the Overview section, we have step card containers; there are 

some material cards that are links to Wiley Blevin Activities  

to be handled with conditional text like so:  

digital-wb_activity_id: r4r_wbtp_activity_00048  

Conditional text applied directly on the range element within the 

text frame for "Blend Words: Plural" 

 
○ Example: digital-wb_activity_id: r4r_wbtp_activity_00048 

To add conditional text in InDesign  
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● Go to Window > Types & Table > Conditional Text 

● Add the conditional text needed within the box and follow the naming 

conventions below for each one. It is important to include what the type of id is 

before the id in the exact same format listed below. 

○ digital-video_id: ffa6e2053b5b45e5817dd946f1423837 

○ digital-pdf_id: r4r_res_0001  

○ digital-epub_id: rtk_text_0005 

○ digital-lesson_id:  r4r_lesson_00001 

○ digital-text: in Lesson 1.2 

○ digital-wb_activity_id: r4r_wbtp_activity_00048 

● Select the content you want to apply the conditional text to and select one or 

more conditions to apply to it as needed. 

 

In the XML, these conditions will appear under the <range> value 

as “condition.” If more than one condition is applied, it will be separated  

by a ‘ | ’ (see example below). Engineering confirmed that this works on their 

end as long as we include the ID type reference before the ID on  

the conditional text itself. 
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Tables 

The engine is built to capture content inside a table starting from a table element.  

You can override cells and rows with element names by tagging them with a unique paragraph-

style sheet name. The engine also captures content styled within a cell  

when that content is also given a unique character style name. 

Note: Indesign doesn't support ordering for different types of objects (paragraph/ table). So 

within a text frame, paragraphs are shown/ordered first, then all the tables are shown/ordered 

next. If you want to indicate, for example, table 1 is between paragraph 2 and paragraph 3, 

and/or table 2 is between paragraph 6 and paragraph 7. There is no good solution to handle 

this on the rule.xml side, but a good practice is to give the embedded table a unique paragraph 

style. 

Applying a Unique Paragraph Style to an Embedded Table 

Applying a unique paragraph style to an embedded table allows the engine to  

capture that name and recognize it as a placeholder for a table, keeping it in line  

with the content.  

In the test case R2K_TG_TextSet06z_ReviewBook_02_CatIsStuck (from the updated Read to 

Know TG Review Lesson template), there are two embedded tables styled differently. One 

table has an indent. The other does not.  

● Apply paragraph style “Table” to embedded table with no indent.  

● Apply paragraph style “Table Indent” to an embedded table with no indent. 
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Note: XML Rules target all tables with placeholder element tags in the XML.  

They let the Development team know the sequence of the tables in the content.   

Test File 

 

 

XML Results 

 

In cases when the table is a stand-alone, where it’s in a text frame with no content before or 

after it, you do not need to do anything.  
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Content on a Different Layer 

Even though there was none found in any of the templates, we did a test case running the 

engine with content on a separate layer. We used the Read to Know TG Review Lesson in the 

text case, placing the “Text Sets table” on a different layer. The XML Transformation Results 

show the content was captured. There were no issues found.    

Test File 

 

XML Results 
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Diacritical Marks and Custom Letter Cases 

Diacritical marks and custom letters are sometimes created as vector path files in InDesign. 

These vector path files are not exported by the engine with enough information for delivery to 

the digital team. For that reason, there are two alternatives that can be applied to ensure this 

kind of content is exported and translated properly to the digital team:  

● As text by applying a character styles 

● As image with an external source file and applying an element label  

As Text Applying Character Styles 

For smaller custom letter(s) and smaller letter(s) with diacritical marks, especially those that 

appear in line with other text, apply one of the character styles listed below to the letter(s). The 

character style lets the Development team know the letter(s) need to be treated differently.  

Character styles:  

Double Macron Below 

Double Macron Above 

Double Breve 

Custom Letter 

How to Apply Character Style to Letter(s) with a Diacritical Mark  

In print, if an anchored image is being used for the letter(s) with a diacritical mark, you do not 

need to do anything with that image. It stays as is on the page for print. What gets used for 

digital is the character style you apply to the letter(s) that is in the text frame. The Development 

team will ignore the font that the character style was applied to and customize the letter(s). 

1. Double-click on the text frame where 

the text is. 
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2. Select the letter(s) that have the diacritical mark and apply the character style. 

    

Follow the same steps for letter(s) with diacritical marks (s) featured in the Flash Cards 

and Articulation Cards, or Alphabet Cards in the future.  

○ Example: letter “oo”  

○ Example: letter “y” 

○ Example: letter “u” 

How to Apply Character Style to Custom Letter(s)  

If an anchored image is being used for a custom letter for print, the same applies here. You do 

not need to do anything. What gets used for digital is the character style you apply to the 

letter(s) that is in the text frame. The Development team will ignore the font that the character 

style was applied to and customize the letter(s). 
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1. Click on the anchored image. 

 

2. Right click on the anchored image and scroll down to Anchor Release. 

 

3. On the keyboard, do Command X to remove it temporarily. 

 

4. Click the text frame. Type the letter q, then highlight it to apply the character style 

Custom Letter.  

Note: This font will not get used. The character style you apply to it will. 
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5. After applying the character style, paste the image back in place to re-anchor the image 

being used for print. 

 

Follow the same steps for custom letter(s) featured in the Flash Cards and Articulation Cards or 

Alphabet Cards in the future.  

● lowercase “q” with the hanging serif at the bottom  

● uppercase “M”  

● lowercase “j”  

● uppercase “I” 

As image with an external source  

For large custom letter(s) and for large letter(s) with diacritical marks, such as the featured 

letters of an alphabet card, creating them as images and then applying element labels to them 

is best for digital.  
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Notes:  

● External sources for images can be .ai, .eps. pdf, .psd, tif, png, or svg  

● Element labels cannot be applied to grouped objects. 

How to Apply an Element Label to an Image 

1. Place the image in the layout of the InDesign file.  

2. Apply the element label “Card Letter” to the entire picture frame. 

 

Anchored Boxes 

The best practice from past workflows was avoiding anchored or embedded text box frames, as 

it previously prevented export as XML. This has changed. The engine can extract the content 

from anchored boxes. Below find an example of an anchored box being exported within the 

XML. There are no steps needed to extract this content; it is handled by the engine.  

Test file 
TEST-R2K_TG_TextSet07_Bones_061-066-ATOMIC 
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XML Results 

TEST-R2K_TG_TextSet07_Bones_061-066-ATOMIC 

  

 

Image frames with unique treatment/effects 

Some image frames have effects applied to the image frames that possibly will need to export 

to the App.  The following effects gets extracted by the engine:

● fill 

● stroke-type 

● stroke-weight 

● corner-tl-radius 

● corner-tl-option 

● corner-tr-radius 

● corner-tr-option 

● corner-bl-radius 

● corner-bl-option 

● corner-br-radius 

● corner-br-option 

● opacity{}
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*For more details see ticket ACE-55 

  

https://jira.sts.scholastic.com/browse/ACE-55
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Style Sheets Reference  

Paragraph Styles

● Bullet (type=list-item) 

● Bullet Invisible (type=list-item) 

● Bullet Invisible Last (type=list-item-end) 

● Bullet Last (type=list-item-end) 

● Bullet Last No Space (type=list-item-

end) 

● Bullet Level 2 (type=list-item) 

● Bullet Level 2 Invisible (type=list-item) 

[Not sure if this applies, perhaps we 

should add for future use case.] 

● Bullet Level 2 Invisible Last (type=list-

item-end) [Not sure if this applies, 

perhaps we should add for future use 

case.] 

● Bullet Level 2 Last (type=list-item-end) 

● Bullet Level 2 Last No Space (type=list-

item-end) 

● Numbered List (type=list-item) 

● Numbered List Invisible (type=list-item) 

● Numbered List Invisible Last (type=list-

item-end) 

● Numbered List (type=list-item-end) 

● Numbered List Last (type=list-item-end) 

● Numbered List Last No Space (type=list-

item-end) 

● Sidebar Bullet (type=list-item) 

● Sidebar Bullet Invisible (type=list-item) 

[Not sure if this applies, perhaps we 

should add it for future use cases.] 

● Sidebar Bullet Last (type=list-item-end) 

● Sidebar Bullet Last No Space (type=list-

item-end) 

● Sidebar Bullet Last Rule Below 

(type=list-item-end) 

● Table Bullet (type=list-item) 

● Table Bullet Invisible (type=list-item) 

[Not sure if this applies, perhaps we 

should add it for future use cases.] 

● Table Bullet Invisible Last (type=list-

item-end) [Not sure if this applies, 

perhaps we should add it for future use 

cases.] 

● Table Bullet Last (type=list-item-end) 

● Table Bullet Small (type=list-item) 

● Table Bullet Small Invisible (type=list-

item) 

● Table Bullet Small Last (type=list-item-

end 

● Table 

● Table Indent
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Character Styles

● Bold 

● Color 

● Color Bold 

● Color Bold Italic 

● Color Italic 

● Color 2 

● Color 2 Bold 

● Color 2 Bold Italic 

● Color 2 Italic 

● Custom Letter 

● Double Breve 

● Folio 

● Highlighted 

● In-Line Graphic 

● Italic 

● Italic Bold 

 

 

 

 

 

 

 

 

 

 

 

 

 

● Italic Heavy 

● Level Indicator 

● Lozenge 

● Macron Above 

● Macron Below 

● Quote Byline 

● Run-In 

● Run-In Hed 

● Run-In Sidebar 

● Small Caps 

● Small Caps Color 

● Teacher Talk 

● Write-On Line 

● Write-On Line Full 

Width 
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